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 What is Rebound?

Rebound makes it easier to use the Windows 3.1 Common Dialog Windows for file selection 
by:

1. automatically remembering the last few Types, Files, and Directories used for each 
application that uses Common Dialog Windows for File Open and File Save As operations.

2. allowing you to specify a few additional Permanent Types, Files, and Directories for each 
application that uses Common Dialog Windows for File Open and File Save As operations.

3. allowing you to perform the following operations from a File Open and File Save As 
Common Dialog Window:
· search for files and open any file found as a result of a search by double-clicking it,
· create a new subdirectory and change the current directory to it,
· move, copy, or delete a selected file, and
· change Rebound's Configuration or Preferences settings.

4. allowing you to optionally display the following file properties at the bottom of the 
Common Dialog Window for a selected file:
· the date and time the file was last modified,
· the file size in bytes, and
· the file attributes: Read Only, Read/Write, and Archive, if present.

5. making the above features available in the Common Dialog Windows for File Open and 
File Save As through either:
·  the Control Menu, or 
· a combination of    pop-up menus and a toolbar.



Using Rebound
(We recommend you print this section for reference the first time through.)

1. In order to use Rebound, first follow the instructions in Installing Rebound

2. Next, open an application that uses Common Dialog Windows for file selection.    For example, open 
the Windows 3.1 version of Notepad.    From within Notepad, select the File Open command.

3. Note that the icon for the Control Menu has been replaced by the Rebound icon and the Common 
Dialog Window has been extended to display the toolbar containing Rebound Operation Buttons.

4. Open any file using the File Name: and Directories: controls in the dialog window.
For example, open the AUTOEXEC.BAT file in the root directory of your boot disk (in this example, 
drive C: is assumed to be the boot disk) as follows: in the File Name: list box, change the type to 
*.BAT, and in the Directories: list, select the root directory c:\, then press Enter or click on OK.

5. Now exit from Notepad.    Open Notepad again and select the File Open command.
When the File Open Dialog Window appears, select the Control Menu by clicking on the Rebound 
icon in the upper-left corner.    Rebound has added Control Menu items named Types, Files, and 
Directories, plus a separator followed by two more items named Options and About Rebound.    
Select each of these options in turn.

6. Now try to click (without releasing the mouse button) on the existing labels from the Common Dialog 
Window named File Name:, Directories:, and List Files of Type:.
As you can see, Rebound has remembered the Type, File, and Directory of the last accessed file, 
namely C:\AUTOEXEC.BAT.    When you opened AUTOEXEC.BAT the first time, Rebound added it to
its list of last accessed files for the Notepad application.
The next time you wanted to open AUTOEXEC.BAT, it was available from the Files option on the 
Control Menu, or from the pop-up menu attached to the existing Common Dialog label for File 
Name:.    Thus the file could be conveniently and quickly selected regardless of the default drive or 
directory displayed in the File Open Dialog Window.

    
Rebound remembers a few of the Last Accessed Types, Files, and Directories for each application that 
uses Common Dialog Windows.    After the Maximum Number of Entries have been added to any Last 
Accessed list and another item is selected, the new item is added as the last (top) entry, all previous 
entries move down one position, and the first (bottom) entry is lost.

Some files are used repeatedly for an application, but possibly not frequently.        For 
example, you might use Notepad to edit your WIN.INI or AUTOEXEC.BAT files, but you do 
not edit these files often.    Still, it is handy to have them in a list for quick access, even 
though the files themselves may be in different directories.    Or, you may want to keep an 
entry from the Last Accessed list for future use.

For these situations, Rebound maintains lists of Permanent Types, Files, and Directories for 
an application in addition to the Last Accessed lists. You can configure Rebound to 
remember a few Permanent Types, Files, and Directories for an application.    See 
Configuring Rebound for more information.





Rebound Features
Rebound can be enabled to provide the features listed below through either or both of:

·  the Control Menu of the Common Dialog Window, in which case the Rebound icon 
replaces the default Control Menu icon, or 

· a combination of pop-up menus and a Toolbar added to the Common Dialog Window.
Display Preferences can be set from the Rebound Preferences Dialog Window.

Types
Displays the list of Last Accessed and Permanent files types (or extensions - the part of the filename 
following the "."), if any, for the current application.    Note that Rebound will only enter a file type in 
the Last Accessed list if you open a file of that type or click on the OK button after entering the file 
type in the File Name: list box.    If you select a type from the Last Accessed list, Rebound moves that
selection to the top of the list.

Files
Displays the list of Last Accessed and Permanent files, if any, for the current application.

Directories
Displays the list of Last Accessed and Permanent directories, if any, for the current application.    Note
that Rebound will only enter a directory in the Last Accessed list if you open a file from that directory 
or click on the OK button after selecting the directory in the Directories: list box.    If you select a 
directory from the Last Accessed list, Rebound moves that selection to the top of the list.

Options

About Rebound
Displays the About Rebound dialog window.



Rebound Options
Rebound can be enabled to provide the options listed below through either or both of:

·  the Options menu entry on the Control Menu of the Common Dialog Window, or 
· a Toolbar added to the Common Dialog Window.

These Preferences can be set from the Rebound Preferences Dialog Window.

Find File
Prompts you to specify the name of a file to find, and the directory path from which to start the 
search.    You can optionally choose to search all subdirectories of the specified directory.    You can 
double-click on any file displayed as a result of a search to open it.

Copy File
Prompts you to specify a new directory path and file name for the file selected in the File Name: list 
of the file selection Common Dialog Window, and then copies the selected file to the new location.    If
no file is selected, Rebound displays an information message.

Move File
Prompts you to specify a new directory path and file name for the file selected in the File Name: list 
of the file selection Common Dialog Window, and then moves the selected file to the new location.    
The original file is deleted.    If no file is selected, Rebound displays an information message.

NOTE: due to MS-DOS limitations, a file cannot be moved across disk volumes (i.e. from one disk to 
another) with this option.

Delete File
Confirms your delete request for the file selected in the File Name: list of the file selection Common 
Dialog Window, and then deletes the selected file.    If no file is selected, Rebound displays an 
information message..

Create Directory
Prompts you to specify the name of a new directory, then creates and changes the default directory 
to the new directory.    This is useful if you want to save a file into a new directory without leaving the 
File Save As Dialog Window.

Configure Rebound

Preferences

Help on Rebound
Displays the Windows Help file for Rebound, REBOUND.HLP.



Installing Rebound
To install Rebound, perform the following steps:

1. Un-zip the files from the archive file RBND10.ZIP.

2. Copy the files REBOUND.EXE, RBNDLIB.DLL, and REBOUND.HLP to your Windows directory, and 
copy the file BWCC.DLL to your Windows SYSTEM subdirectory.    (BWCC.DLL contains the custom 
controls used by Rebound to display the About Dialog and the Configure Dialog Windows.)

3. Edit your WIN.INI and add REBOUND.EXE to the LOAD= line following the keyword [windows].    For 
example:

[windows]
spooler=no
load=REBOUND
run=
Beep=Yes
…

4. Save the changes to WIN.INI and exit Windows.

(As an alternative to steps 3 and 4, in Windows 3.1 you can create a Program Item for Rebound and 
place the icon in the Startup Program Group of the Program Manager to achieve the same effect.)

5. Restart Windows.    Rebound should now be operational.    See Using Rebound for usage details. 



Background on Common Dialog Windows
Windows 3.1 provides built-in support for Common Dialog Windows to perform common 
user operations such as File Open, File Save As, Find and Replace Text, and Choose Font 
from within an application.    Applications display Common Dialog Windows by calling 
Windows-supplied functions located in a dynamic link library named COMMDLG.DLL, which 
is located in your Windows SYSTEM subdirectory.

Common Dialog Windows provide a consistent interface across all applications that use 
them.    Examples of Windows 3.1 applications that make use of Common Dialog Windows 
include Excel 4.0, Notepad, Paintbrush, Write, Windows Help, and the Browse button in the 
Program Manager's File Run Command Dialog Window.

However, there is a drawback to using Common Dialog Windows.    You still have to climb 
and descend directory trees and manually select drives or file types to locate the file or 
directory you want.    Common Dialog Windows provide no inherent method for tracking 
previously-used or frequently used files across sessions for an application.



New Features
Rebound is first and foremost, a new name for an existing product, namely Open Axess.

Rebound adds the following new features over Open Axess V. 2.10:
1. Quick Open,
2. additional File Operations (Copy, Move, Delete),
3. a pop-up menu interface to the lists of files, types, and directories, attached directly to 

the existing labels on the file selection Common Dialog Window,
4. the choice of pop-up menus and a Toolbar and/or the familiar Control Menu interface, 

each of which can be separately enabled or disabled.



Open Axess
The last version of Open Axess was 2.10.    Work on a new version of Open Axess has been 
underway since early in the year (1993).    Once we saw the work of others for Common 
Dialogs, such as the 3-D controls Dynamic Link Library - CTL3D.DLL (Microsoft),    
Boomerang for Windows (shareware), and the Common Dialog Extensions (shareware), we 
decided it was time to release the new version.

The name change from Open Axess to Rebound is merely to distinguish our product from
the dozens of other products, particularily for the PC market, that have the words Open, 
Axess, or Access in their name.

The idea for the File Operations came from the WordPerfect for Windows v. 5.1 Open Dialog 
window, which we used while developing the WordPerfect macro for Open Axess.    The idea 
for Quick Open was primarily influenced by the Recall option on the File Menu in Windows 
Draw v. 3.0 from Micrografx, Inc.



Displays the Rebound list of Last Accessed and Permanent Files.



Displays the Rebound list of Last Accessed and Permanent Directories.



Displays the Rebound list of Last Accessed and Permanent Types.



Find a File.



Create and Change Directory to a new subdirectory.



Move the File currently selected in the File list box.



Copy the File currently selected in the File list box.



Delete the File currently selected in the File list box.



Display the Rebound Configuration Dialog Window.



Display the Rebound Preferences Dialog Window.



Display Windows Help on Rebound.



Display the selected File's last modified date/time and Read, Write, Archive attributes, if 
present.



Quick Open
Some commercial applications, like Microsoft Word for Windows, Excel, and Micrografx 
Windows Draw, keep a list of the most recently used files right in the File Menu of the 
application.    Other applications, like Micrografx Windows Draw, add a cascading menu 
entry to the File Menu which contains a list of recently used files.    We thought this would 
be a nice feature for Rebound.    The result is Quick Open.

The Quick Open option allows you to completely bypass the File Open Common Dialog 
Window to open a file by inserting a cascading menu entry entitled Quick Open in the 
application's File Menu.    When selected, this option cascades to display the Rebound list of 
Last Accessed and Permanent files.    Quick Open must be activated on a per-application 
basis using the Rebound Configuration Dialog Window.

If you use the Rebound Configuration Dialog Window to change Rebound's list of Last 
Accessed and Permanent files for an application that has Quick Open enabled, these 
changes will not be present on the Quick Open menu until the next invocation of the 
program.    Similarily, if you enable Quick Open for a running application, you will have to 
exit and run the application again for Quick Open to take effect.

Although Quick Open does not require you to select a file from the File Open Common 
Dialog Window, Quick Open must call COMMDLG.DLL to open the file.    This means that you
will see the File Open Common Dialog Window appear briefly on the screen before the file 
opens.    (Our attempts to prevent the dialog display were unsuccessful.)

One other point: Quick Open works beautifully on the applets provided with Windows (such 
as Notepad, Write, Paintbrush, etc.).    Other applications, especially those that provide their
own capability to modify menu contents and structure (such as Word for Windows and 
Excel), don't take kindly to another process trying to modify their menus.    You will have to 
experiment with individual applications to see if Quick Open can be used.



Rebound-Enabled Common Dialog
The primary functionality provided by Rebound, that is, lists of Last Accessed and 
Permanent Types, Files, and Directories, is now accessable via pop-up menus attached to 
the existing labels for List Files of Type:, File Name:, and Directories:, respectively, in 
file selection Common Dialog Windows.    These pop-up menus cannot be disabled when 
Rebound is running.

Rebound can be configured to display the lists of Last Accessed and Permanent Types, Files,
and Directories, and other Rebound Options from the familiar Control Menu interface 
provided by Open Axess.    Additionally, Rebound Options can be accessed from the Option 
Buttons Toolbar rather than (or in addition to) the Control Menu of a file selection Common 
Dialog Window.    Use the Rebound Preferences Dialog Window to set these display options.



This screenshot shows a file selection Common Dialog Window with all of the Rebound 
display Preferences enabled.



The REBOUND.INI File
Rebound maintains an initialization file called REBOUND.INI.    This file contains your settings for Last 
Accessed and Permanent Types, Files, and Directories for each application that uses Common Dialog 
Windows for file selection.    REBOUND.INI also contains global settings as described below.    When 
you first use Rebound after installation, the REBOUND.INI file does not exist and is created in your 
Windows directory.

Types, Files, and Directories selections for an application can be maintained from within the application 
using the Rebound Configuration Dialog Window (available from either the Control Menu or the Toolbar 
of a file selection Common Dialog Window when Rebound in enabled).    The REBOUND.INI file can also
be viewed and edited using a text editor such as Notepad.    We recommend that you exit Windows after 
using Rebound for the first time prior to editing REBOUND.INI in order to ensure that the file is written 
completely.    Note that changes made to REBOUND.INI using an editor will not take effect until you 
close Rebound and restart it.

An example of the contents of the REBOUND.INI file is shown below.    The application name is shown 
delimited by square brackets [], followed by the Rebound settings for that application.    The [Rebound] 
heading stores the following values set from the Rebound Preferences Dialog Window:

MaxList
stores the current setting for the Maximum Number of Entries field

SystemMenu
stores the current setting for the Show System Menu checkbox

Properties
stores the current setting for the Show File Properties checkbox

AppIcon 
stores the current setting for the Show Program Icon checkbox

Button Operations    
stores the current setting for the Show Operation Buttons checkbox

The LD, LT, and LF prefixes denote the entries for last accessed directories, types, and files, 
respectively.    The PD, PT, and PF prefixes denote entries for Permanent selections.

[Rebound]
MaxList=5
SystemMenu=N
Properties=Y
AppIcon=Y
Button Operations=Y

[Notepad]



Advanced Open=Y
Open Menu=&Open...
LD04=
LD03=c:\util\win31\
LD02=d:\lang\bc\include\
LD01=c:\borlandc\doc\
LD00=c:\misc\rmw\nets\
LF04=c:\borlandc\doc\manual.rw
LF03=c:\borlandc\doc\custcntl.rw
LF02=c:\borlandc\doc\bwccstyl.rw
LF01=c:\borlandc\doc\bwccapi.rw
LF00=c:\misc\rmw\nets\oomethod.
LT04=*.txt
LT03=*.*
LT02=*.hpj
LT01=*.rw
LT00=*.
PD04=
PD03=
PD02=c:\util\win31\
PD01=d:\usr\westman\
PD00=c:\misc\axess\
PF04=
PF03=c:\util\win31\axess.ini
PF02=c:\util\win31\win.ini
PF01=c:\util\win31\setup.txt
PF00=c:\misc\axess\axess.hpj
PT04=
PT03=
PT02=
PT01=*.ini
PT00=*.txt

As with REBOUND.EXE, RBNDLIB.DLL, and REBOUND.HLP, the REBOUND.INI file must be located in
your Windows directory.



Rebound Preferences
Global Rebound settings are stored in REBOUND.INI, and are set using the Rebound 
Preferences Dialog Window.    This dialog can be invoked in any of the following ways:

1. Single-click on the Rebound icon on the Windows desktop (if enabled) and select the 
Preferences menu item, or

2. If the Rebound Icon appears instead of the default Control Menu icon on a file selection 
Common Dialog Window, select the Options menu item, and then select the 
Preferences menu item on the the Options sub-menu, or

3. If the Rebound Operations Buttons toolbar is enabled, click on the Preferences button.

The following preferences can be individually enabled or disabled:

Show System Menu
When checked, enables the replacement of the default Control Menu icon with the the Rebound icon
on the Common Dialog Window for file selection.

Show File Properties
When checked, Rebound resizes any subsequent file selection Common Dialog Window to include 
the display of a Toolbar containing the following file properties for a selected file:

· the date and time the file was last modified,
· the file size in bytes, and
· the following file attributes, if they are set: Read, Write, and Archive.

Show Program Icon
When checked (and Rebound is running), enables both the display of the Rebound program icon on 
the Windows desktop and the appearance of Rebound in the Windows Task List.    When unchecked,
the only way to determine if Rebound is running is the appearance of Rebound Features in a 
Common Dialog Window.    If both the Show System Menu and Show Operations Buttons options 
are disabled, the REBOUND.INI file must be edited to enable the Show Program Icon option.

Show Operation Buttons
When checked, Rebound resizes any subsequent file selection Common Dialog Window to include 
the display of a Toolbar containing Rebound Operation buttons.

Maximum Number of Entries



Configuring Rebound
When Rebound is enabled, it can be configured from a file selection Common Dialog 
Window using the Options menu option of the Control Menu, if enabled, or from the 
Configure button on the Toolbar, if enabled, depending on the current Preferences settings.

The Configuration Window displays the following settings for the current application:

Access Type, File, or Directory
Select the list of entries which you wish to view or edit.

Mode
Last Accessed The last few Types, Files, and Directories that you selected within any given 

application.    These selections are maintained in the REBOUND.INI file, located in 
your Windows directory.    If you select an item from a Last Accessed list, Rebound 
moves that item to the top of that Last Accessed list.

Permanent

Quick Open Enabled
When checked, enables the Quick Open option for the current application.

Open Menu Text
Quick Open needs to know the exact menu text of the application's File Open command.    In most 
applications, this is "Open...", but some applications deviate from this standard.    The Open Menu 
Text field allows you to configure Quick Open for those applications that do not use the standard 
menu text. 

Entry List
Displays the list of entries for the current settings of Access and Mode.    If more than 5 entries exist,
scroll bars are added to the list.

Buttons
OK Accepts the current dialog window settings.
Keep Allows you to designate the selected entry from the Last Accessed list of Types, Files, or 

Directories in the Rebound Configuration Dialog Window as a Permanent entry for the 
current application.

Remove Allows you to remove the selected Type, File, or Directory from the list of Last Accessed 
Types, Files, or Directories respectively.    You would typically Remove an entry after you 
have made it Permanent.

Purge Removes all entries from the Last Accessed list of Types, Files, or Directories in the 
Rebound Control Menu options for the current application.



Files Contained in This Package
The following files are contained in the archive file REBOUND.ZIP:

1. REBOUND.EXE the Rebound executable program file
2. REBOUND.HLP the Rebound Windows Help file
3. RBNDLIB.DLL the Rebound Dynamic Link Library
4. BWCC.DLL the Borland Windows Custom Controls Dynamic Link Library (required)
5. README.TXT a text file containing instructions and revision history

To extract these files, use UNZIP or another file extraction utility that reads ZIP files.    
Please note that the Rebound Windows initialization file REBOUND.INI is created in your 
Windows directory the first time you use Rebound.



Registering Rebound
Rebound is Shareware, and is Copyright 1993 by Steven Gutz and Randy Westman, all 
rights reserved.    You may use Rebound for thirty days to evaluate it.    If you think Rebound
is useful and you wish to continue using it, please print & fill out the Registration Form and 
send it with your payment of $20 (U.S.) to the address on the form.    Registered Users of 
Open Axess V. 2.10 or earlier may register Rebound for the upgrade fee of $5 (U.S.).    A 
postal money order is preferred, payable to Steven Gutz.

Alternatively, CompuServe members can use their credit card to register Rebound using 
CompuServe's online Shareware Registration Database.    GO SWREG and follow the 
instructions there to register shareware.    The Registration ID is not known at this time.

Sorry, we cannot directly accept credit card payments.

When you pay your shareware fee, we'll show you how to use Rebound in Windows 3.1 
applications that do not use Common Dialogs, but can register Dynamic Link Libraries 
(DLLs) and call their functions.

If you wish to obtain a site license for Rebound, contact the authors for arrangements.

We strive to make the latest version of Rebound available as follows:

1. on the Internet via anonymous ftp at ftp.cica.indiana.edu (129.79.20.84) in either 
pub/pc/win3/uploads or pub/pc/win3/util as rbnd10.zip.

2. on CompuServe in the Advanced Windows forum (GO WINADV) in the File Utilities 
Library as rbnd10.zip.    Do a search for the keyword REBOUND.

To contact us, you can write, or send CompuServe and/or Internet electronic mail to one of 
the addresses shown in the About Rebound Window.

Steven Gutz Randy
Westman



Rebound 1.0 Registration Form
Send $20 (U.S. funds - postal money order preferred) with this completed form to:

Steven Gutz
R.R. #5
Pembroke, Ontario
CANADA    K8A 6W6

Name:           __________________________________________

Address:        __________________________________________

     __________________________________________

Province/State: __________________________________________

Country         __________________________________________

Postal Code     __________________________________________

Internet Address (optional):    __________________________

CompuServe ID (optional):       __________________________

Your signature below acknowledges the following:

USERS OF REBOUND MUST ACCEPT THIS DISCLAIMER OF WARRANTY:
Rebound is supplied 'as is'.    The authors disclaim all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any 
purpose.    The authors assume no liability for damages, direct or consequential, which may 
result from the use of Rebound.    In any case the maximum liability of the seller will be 
limited exclusively to product replacement or refund of purchase price."

Your signature            ________________________________

Thank you for registering Rebound !
Steven Gutz & Randy Westman



Control Menu
If present for a window, the Control-menu (sometimes called the System Menu) is located 
in the upper-left corner of that window.    The Control Menu typically contains menu options 
for sizing, moving, and closing the window.    When an application uses the Common Dialog 
Dynamic Link Library COMMDLG.DLL to perform a file selection, Rebound can be configured
to replace the default Control Menu Icon with the Rebound icon and adds Rebound Features
to the Control Menu.



Permanent
An entry in the list of Types, Files, or Directories that is always present for the current 
application.    Permanent Types, Files, and Directories are denoted by a leading  in the 
Rebound Control Menu options.    The Permanent attribute is assigned from the Rebound 
Configuration Dialog Window.    The maximum number of Permanent Types, Files, and 
Directories you can specify for each application is governed by the value of    Maximum 
Number of Entries.



Rebound v. 1.0 © 1993 by Steven Gutz and Randy Westman.    All rights reserved.



Maximum Number of Entries
The maximum number of items in any Rebound list of Last Accessed or Permanent Types, Files, or 
Directories is set to 5 by default and can be changed by editing the value of Maximum Number of 
Entries: in the Rebound Preferences Dialog Window.    You can use the controls provided to increment 
or decrement the displayed value, or select the value and key in a new one.    The minimum value is 1 
and the maximum value is 50.

Since Windows does not support vertically scrolling menus, the number of items in an Rebound list that 
can be displayed depends on the resolution of your computer monitor.

Note that you can edit the REBOUND.INI file directly and change the value of MaxList (under the 
keyword [REBOUND]), but the change will not take effect until you restart Rebound.    We recommend 
that you use the Rebound Preferences Dialog Window instead.




